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Installing Maven Plug-in

You can install the Maven plug-in using the GUI, Console, or Silent mode.

Before you begin

If you want to install TIBCO ActiveMatrix BusinessWorks™ Maven Plug-in, install Apache
Maven from https://maven.apache.org/download.cgi and set MAVEN_HOME in the
Environment Variables.

For more information on how to install maven plug-in, see the "Installation Modes and
Procedures" in the ActiveMatrix BusinessWorks Installation.
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Post Installation tasks

Post installation tasks are additional tasks that you might have to perform after
installation.

Before you begin
Complete the installation before running the post installation tasks.

o Note: In case Apache Maven is not installed before installing ActiveMatrix
BusinessWorks Maven Plug-in, install Apache Maven and then run
install.sh/install.bat from <TIBCO-HOME>\bw\6.x\maven to install Maven
Plug-in.

Maven Plug-in versions compatible with ActiveMatrix BusinessWorks

The following table shows the maven plug-in versions compatible with ActiveMatrix
BusinessWorks.

ActiveMatrix BusinessWorks Version Maven Plug-in Version
6.8.0 2.9.0
6.8.0 HF-001 2.9.1
6.8.1 2.9.2
6.8.1 HF-001 2.9.3
6.9.0 294
6.9.0 HF-001 2.9.5

TIBCO ActiveMatrix BusinessWorks™ Maven Plug-in



6 | Post Installation tasks

ActiveMatrix BusinessWorks Version Maven Plug-in Version
6.9.1 2.9.6
6.9.1 HF-001 2.9.7
6.10.0 2.9.8
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Unit Testing

Unit testing in ActiveMatrix BusinessWorks consists of verifying whether individual activities
in a process are behaving as expected. While you can run unit tests on processes at any
time during the development cycle, testing processes before you push the application to
the production environment might help you to identify issues earlier and faster.

Note: To get familiarized with the Unit Testing Samples, see "Unit Testing" in
the TIBCO ActiveMatrix BusinessWorks™ Samples.

Running Test Assertions

Unit tests focus on testing small units of work, which in ActiveMatrix BusinessWorks maps
to individual processes or subprocesses. Ideally this is done in a standalone manner, with
no touchpoints or dependencies on other components or interfaces. This is distinct from
interface or system testing that would test the service or operation as a whole. Interface
tests are run using other tools such as SOAP Ul.

Adding Unit Test Assertions

To add unit test assertions in TIBCO Business Studio for BusinessWorks, follow these steps:

Before you begin
e The UnitTestDemo.zip file must be present in an accessible location.

Procedure
1. In TIBCO Business Studio for BusinessWorks, on the demo project, right-click the
Tests folder and select New > Add Test File.

The New Test File wizard displays with the Test File page.
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Note: You can also create a Test file in the subfolder created under the
Tests folder.

2. In the New Test File wizard, change the file name to GetDistanceUnit-NAM.bwt and
keep the Tests folder as default. Click Next.

a Pew Test File

Test File a

Create a new test file

Select parent Test folder and target file name:

Test folder: [ demo/Tests | Browse..

File: | GetDistanceUnit-NAM.bwt |

® < Back MNext > Finish Cancel

3. Add the GetDistanceUnit.bwp to the process and click Finish.

TIBCO ActiveMatrix BusinessWorks™ Maven Plug-in
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#) New Test File

¥

Select Processes

Select processes from the given project.

v [m] <G Processes
w B distance
M@ GetDistanceUnit.bwp
v [] 8 misc
[]€82 LoadData.bwp
[]488 LogError.bwp
[]€28 ProcessDataEMEA.bwp
D@ ProcessDataMAM.bwp
v [] 8 service
[]488 UnitsService.bwp

v [] #8 temperature
[]€88 GetTemperatureUnit.bwp

Select All | [ Deselect Alli

@ <Back | Next> Finish Cancel

4. In the Project Explorer, open GetDistanceUnit.bwp and click the
distance.GetDistanceUnit process (green box) and select the Properties tab. Since
this process is added to the Tests file, the Tests tab appears on the Process panel.
Click the Tests tab and the created file is selected in the Available Tests dropdown.

TIBCO ActiveMatrix BusinessWorks™ Maven Plug-in
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Note: Clicking the red cross-mark Delete selected bwt file deletes the
test file permanently.

5. Right-click the Start activity and select Add Test > Add Input. Click the Tests tab

under Properties and add NAM in the Content column for the region field.

o Note: NAM should not contain any double quotes ("").
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o Note: The process does not need to be saved after adding the test inputs
and assertions.

Right-click the End activity and select Add Test > Add Input. Click the Tests tab

under Properties and expand AssertType+ and SEnd-input, which is both the sides of
the mapper.
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Drag the string|boolean|... element from the right-hand side to any element on the
left-hand side of the mapper underneath SEnd-input. The Drop wizard opens to
select a data type. Select the "String" data type and click Finish.
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Q Drop O >
Instantiate Choice
(®) Map to
string v |
® Finish Cancel
The testinput and goldinput fields are displayed.
1 Properties 12 [ Probluns| (@ EWHep B Consolei
B End (End)
& Test File: (demo/Tests/ GetDistanceUnit-NAM
W Assertion Mode: Primitves
Tests
_'"L“__ | |Data Source ._Fﬂi_c_t_il_:_rls_c_qgs_!.!ngi XPath Expression
AR v & SEnd-input v g
RBL unit =—w [ Primitive-Assertion
i metric s ] AscertType
RBL subUnitType? = w [ string
123 numberOfSubUnits? BRL testinput
[t goldinput

8. In the Data Source tab, drag "unit" to the testinput field. This is the value that you
are evaluating in the assertion. Add miles as an input to the goldinput field.
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General

Tests
Input

] Properties 22 ||,:_ Problems| (Z) BW Help B Console

0O End (End)

 Description |
Input Editar

Fault Editor |

Test File:

Jdemo)/Tests/ GetDistancelnit-MAM

Primitives

Data Source | Functions | Constants

v 5% SEnd-input
REL unit
1 metric
REL subUnitType?

vy
— Primitive-Assertion
v B AssertType

XPath Expression

~ [ stning
123 numberOfSublnits? RBL testinput SEnd-input/tns:unit
BEL galdinput “miles’

9. Right-click the AssertType and choose Duplicate. Right-click on Primitive-Assertion
and choose Expand All. Under the second AssertType element, right-click the
AssertType and choose Remove Mapping. Drag the string | boolean... element from
the right-hand side to any element under $End-input on the left and choose the

"boolean" data type. Drag the "metric" element from the left onto the testinput field
under Boolean and enter false() in the goldinput field.

m Properties I3 |_',_ Prohla’nsl @ B\N‘Help| =] Cmsnl!.
0O End (End)

General
Description
Inpast Editor
Tests.

Inpul

Teest File:

[ rderni Tests/ GetDustancelna-Hant

Aavertion Mode: Brimitives

| Data Source | Functions | Constants

APath Expression
Fautt Editor v 5% SEnd-input v Bl
ABE unit — [F] Prmithve-Assstion
Vil metsic w (B AssetType
Bt sublUnitType? w [ string
123 numberQfSulbUnits? Bl testinput $End-input/tnsunit
i goldinput “riles”
v [B] AssertType
~ [ boolean
1 testinput SEnd-input/tns:metic
> i goldinput False()

v [ AsserType
& string | boolean | int |

10. In a similar way as above, complete the mappings so that you also assert
"subUnitType" and "numberOfSubUnits"

TIBCO ActiveMatrix BusinessWorks™ Maven Plug-in
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Fault Editar

| /i Tests/ GetDistancelnit-NAR

Primitives

o o

Tl Properties. £ [ Froblems| (] BW Help E] Conscle |
0O End (End)

_G"_"'_'."i__- Test Flle:

 Desaription .

nputEsitoe| Aosertion Mude:

Tests

Input Dita Saurce | Functions | Canstants|

~ 44 SEnd-input
HEL unit

W mmetric

BBL sublinitType? —
121 numberOfSublnits?

v By
—w [B] Primitive- Assestion
o [E AasertType
~ [ string
RBE testinput
ABE goldingut
———w & AssertType
+ [ boolean
I testinput
19 goldinput
e [ AssertType
w [ string
ABE testinput
AR goldingut
w & AssertType
~ [ it
123 testinput

- - 123 goldingut

» B AssertType”

APath Bpressen

SEnd-inputinsunit

“miles”

SEnd-input/tns:metric
false()

SEnd-inpus/mssublnitType
“yards®

SEnd-input/msnumberdfSublinis
1760

11. To add a new test file, right-click the Tests folder and select New > Add Test File. In
the File field, add the name of the file as GetDistanceUnit-EMEA.bwt and click Next.
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#) New Test File O %

Test File E]
Create a new test file

Select parent Test folder and target file name:

Test folder: | demo/Tests ] 'Brmus:.._

File: | GetDistanceUnit-EMEA.bwt ]

® < Back Mext = Fimish Cancel

12. Select GetDistanceUnit.bwp and click Finish.
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g Mew Test File Ll X

Select Processes

Select processes from the given project.

v [m] <G Processes
v [ 8 distance
[1£28 GetDistanceUnit.bwp
v [ ] ## misc
[ LoadData.bwp

[]£88 LogError.bwp
[]€82 ProcessDataEMEA bwp

[]€88 ProcessDataNAM.bwp
v [ ] 8 service
1488 UnitsService.bwp

~ [] #8 temperature
[]€28 GetTemperatureUnit.bwp

 Select All | Deselect Al

@ | <Back |  Next> Finish |  Cancel

13. In the Project Explorer, open GetDistanceUnit.bwp and click the
distance.GetDistanceUnit process (green box) and select the Properties tab. Since
this process is added to the Tests file, the Tests tab appears on the Process panel.
Click the Tests tab and the demo/Tests/GetDistanceUnit-EMEA test file is selected in
the Available Tests dropdown. If not, select it manually.
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14. Right-click the Start activity and select Add Test > Add Input. Click the Tests tab
under Properties and add EMEA in the Content column for the region field.
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15. Right-click the End activity and select Add Test > Add Input. Click the Tests tab

under Properties and expand AssertType+ and SEnd-input, which is both the sides of
the mapper.
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1 Properties 1 |[5 Problems| (@) B’WHdp| 2 Console

D End (End)

= Test File:

fdermo/Teste GetDistancelnit-EMEAS
Description
Input Editer
Tests
Input
Fault Editor

Asserticn Mode: Primitives

Data Source Functions Constants ¥Path Expression
» §& SEnd-input v o
v [ Primitive-Assertion
w AszentType+

& sining | boolean | int | dateTime | float | double

16. Repeat steps 7, 8, 9, and 10 to set the assertions for GetDistanceUnit-EMEA with

"unit", "metric", "subUnitType", and "numberofSubUnits".

The output looks as follows:

[ Properties =1 | %] Probloms| (7 B Help &) Cansale

0 End (End)
General i : = :
| Tesi File: elermioy Tesks/Goet Dist snce Unit -EREA
Description | 3
ingiak Ecitos | Assertion Mode: Primitives
Tests
Irspnst Dizta Source | Functions  Constarts AFath Expressson
FaultEditer | o 24 sendinput | w2y
BBt unit one B Primitre-fssedion
¥ metic v [ AssetType
Bt subUriType? ~ & string
123 number(fSublinits? Bt testinput SEnd-input/tnsiunit
ML gesdinput “kilormetes”
~ B AzzenType
w [ boolesn
1 testinput SEnd-input/tns:metric
-1 geMinput trised])
v B AssetType
w B tring
BBt testinput SEnd-input/tnssublinitType
- W goidinput “metres”
v Bl AssetType
- w @ int
123 testinput SEnd-input/tns: numberDfSublines
D —— T 1000
Bl AsserType*

To run Unit tests in TIBCO Business Studio for BusinessWorks, see Running Unit Tests
in Studio.

Running Maven from Command Line

To run Maven plug-in from command line, perform the following steps:

Procedure

1.

Open your command prompt and navigate to the location where your demo project
is present.

Run the command clean initialize site package on your command prompt
terminal.

TIBCO ActiveMatrix BusinessWorks™ Maven Plug-in
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This produces the same result as running Debug within TIBCO Business Studio for
BusinessWorks.

ent\target

o Prompgt -

.io.kWriteFlusher - update Writef

d=true 141/141+1 Wri

ctor Summary:

Unit Test Reports and Test Coverage Reports

The "site" goal that is included in the Maven debug configuration in TIBCO Business Studio
for BusinessWorks and on the command line produces unit test reports and test coverage

TIBCO ActiveMatrix BusinessWorks™ Maven Plug-in
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reports. These test reports are located at \demo.application\target\site.

Procedure
1. Open the index.html using the browser.

2. Select Project Reports > bwtest.

This shows a summary of the tests that were run and whether they passed or failed.

L e | ool

I veried b Te e Cenenoie B weemern - ue B o I veossee ) Mo

demo.application

Crwics BW Test Report

P
e
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[Summary] [Fackage List] [Test Cases]
[ |
F 0 [
Package List
[ssmmary] [Faceage L) [re cases]
i okt F:-I_ Tadtres Sl Fucoran Rair:
= ey 2 0 a a ey

3. From the same folder, open bwcoverage.html.

This shows a summary of which processes and activities are covered by unit tests, for
the entire project and as a breakdown for each process.
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Limitations for Unit Test Assertions

The following are the limitations for the Unit Test Assertions:

e ActiveMatrix BusinessWorks must be installed on the same server where the tests are

to run.

e Unit Tests can currently only be invoked with Maven.

Running Activity Assertions

To run activity assertions in ActiveMatrix BusinessWorks, follow these steps:

Procedure

1.

Right-click on the activity from the process or subprocess and select Add Test > Add
Assertion.

It adds the Test tab to the activity.

. On the Tests tab, navigate to the Assertion Mode dropdown.

The Assertion Mode dropdown has two modes:
e Primitive: In this mode, only the primitive types of elements are tested.

e Activity: In this mode, the complete activity outputs are tested.

Project Explorer & ¥ " U | @ CitdownSubProcessbwp @ Protesiove | @ fcomplecMapper bep ¢ PWEARFecagerMajojava ComplexMeopperFinal bt
T 5 e e A Pt com Ak A | g Pl
B Process bap e o Ty 8-
& Service Diescripbors o by ] n Hecontly Lsed
~ Resouroes D]
| Mapger [rad Favorine Palattes
@ Schemas: | " o
i -
Masdhe Dessriptors a8
- o Tasts | Bamic Activites B
& ASDEWSZRFA mi - -
. M. Comple Mspperfialf it [ Properties |7 Toblems & B Help| B Consaie) + Seorch| = TR TR
B buikd properies
& pomamil w | = Mapper (Mapper]
o ¥ RAL MO [Boe @M. ARL T T | Gererd ¥ 4
i . | e Teat File: £ wwnuleabsrae b il i n it senskesfarue el
@ complexmepperting.compledtipper Assertion Mode: Al il i
& T
Properies i
s rp e s
w G Artvities Input Diata Source Funcions Fol
@ Stant Output ¥ SMapper
0 End Tests
© Mapper

Select the Activity option from the Assertion Mode dropdown. The complete activity
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output schema

gets loaded with an editable value field under the Assert Type node.

Map the activity variable from the datasource section (in Image you can see it is
Mapper) to activityTestinput field.

Progect Exlores Bl % 7 7T P @ Cadoensubitoessbwp 8 Protess e | “rompledapoenown U 0 PWESRRackagerMojejors  © ComplesMapperFeal 1 bt B
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2 Pobcies [rTT— |
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8 AZDEWS2REA ma - £
e T e B T Prapenies |7 Froblems 7 BAf Help| B Corsole] + Seach| MbhE[anE® "0
i buld properties
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P | Text File: i Sl e b I ez ilerebd
= @ comnplesrrappertnal Toos Aasertion Mode: Retnily -
2 Properties
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@ Stk Clutput » 5 EMapper = B2 hdappes
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"
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™ sianpd? -
4. Provide the gold input to all the elements of an activity schema that is under the
assert node.
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o Note: You do not have to save the process after adding test inputs and
assertions. Also if the schema having the fields with data type decimal,
double, float then add the value in the decimal format, for example, 1.2 or
4.3234.

Using Gold Input From File

Procedure
1. Right-click the activity from the process or subprocess and select the Add Test > Add
Assertion option.

The Test tab is added.
The Assertion Mode dropdown list has two options: Primitive and Activity.
Use the Primitive option to test only the primitive type elements.

Use the Activity option to test the complete activity output that can contain a
complex schema.

2. Select the Activity option.

e Edit Diagram Mavigate Search Project Bun Window Help
| b & J . BAGCEMr e O TSP
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AIDEWSZRF,ml wl
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fo. = @Al B [Boe@m. (SR T O Genenl | =
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& complarrapperfinal comglechapper e Assertion Mode: Sctivity o
5 Properties e Wmite
= Refgrences Lol Activity
- Adtivitics Ingut Data Source Functions ol
@ St Dupuat » # SMapper ~ g Mapper
OEnd Tests v [ Autivity-Assedtion
* Mapper  acthvinyTestingy $Mapper
s 8 PszertType
~ i Boak
0t jchn?
- name?
et descriptioe
. gutforN o
 releaseDm
W iabage?
4 signed? bl

The Gold Input From File checkbox is displayed.
3. To provide the gold input through an XML file, select the Gold Input From File
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checkbox.

The AssertType and testFilePath fields are displayed.

General
Description
Tags

Input Editor
Tests

Input
Output

[ Properties % |[2! Problems () BW Help E Console
= Mapper (Mapper)

%,

MAE® § = 8

Test File: ‘RestServiceBi. dingMocked ‘
Assertion Mode: Activity A4
Gold Input From File:

doc('file:///Tests/GoldFiles/Mapper3.xml')

Data Source} Functions | Constants ‘

> $% $Mapper

v = Mapper

\ v [E Activity-Assertion
RABC activityTestinput

o——v [Z] AssertType

Bt testFilePath

XPath Expression

$Mapper

doc('file:///Tests/GoldFiles/Mapper3.xml')

4. Map the activity variable from datasource section to activityTestInput field.

5. Browse the gold input file from the workspace and select the gold input file. This
modifies the testFilePath file in XML.
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@ (] File Selection

v &} MainProcessWithUnitTestDemo
> [ .settings
= WebResources
= META-INF
(= Policies
> [=Processes
> [=Resources
> [=Schemas
> (= Service Descriptors
v [=Tests
v (= GoldFiles
|X| Mapper1l.xmi
|X| Mapper2.xml
> (= MockFiles
|m| pom.xml

v W

@ corcel (D

6. Alternatively, in the testFilePath field, use the doc function from the URI function
and provide the input file path in the format file:///inputFilepath. In the case of
Unix systems, please provide the absolute path preceding with an extra forward
slash.

Example: doc(file:////home/Test/Mock_files/)
7. Provide the relative gold input file path in the testFilePath field.

You can create a separate folder for gold input files under the "Tests" folder. The
relative path has a value like doc file:///Tests/UnitTestingsComplex.xml. It is
mandatory to provide the Tests folder name also in the relative path. In case of Unix,
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provide the relative path as file:////Tests/Mock_files/Activity_Assetion_IP_

File.xml .

Note: This feature is available with TIBCO ActiveMatrix BusinessWorks™

Maven Plug-in 2.5.0 and above.

8. To create a gold input file, run the activity for which you want to add the assertions.

9. Observe the Tests tab > Data Source section schema. Right-click the activity name
on the Debug console and select Generate Gold Input File either from the Input job

data or Output job data.

Fle Edit Diagram Navigate Search Project Run Window Help

(=4 LY I S 3 ORGAS OB My iEvOvYRYBIviLvivodOvDv|m
Segoe Ul 9 BI|AvoOvy svov|@RveaRviy 8 v |[100% Q i@ B
4 Debug (& Project E.. # Servers @ Business.. © O & Application.module @ Process.bwp & = 5 0Vari.. %Bre.. Exp.. RJo.. ¥ BWAss.. BDe.. O
b LR AR I - = IS BB
~ %l <launched> BWEclipseAppNode @localhost:9090 S50 madule Pro . Mapper
~ %l application.module.Process Name Value
~ @ application.module.Process [bw0a100] - (Viewed | Input - v — e ey e e
o ——— Cinrur <tneMannarinnit vminetng
® Timer [bw001g0.3] - (Done) Recently . output AppEF Seect Al m
~ Mapper [bw001g0.4] - (Done) Favorite .. 7
> @ application.module.Process [bw0a101] - (Compl =] Palette Li.. « ® Copy Values
@ Iﬁﬂji B - Copy Variables
Timer Niapper Basic Activities El Generate Gold-Input File...
@@ ¥ Generate Mock-Output File...
File
FTP
e
General
Activities
(%]
HTTP
A
= =

B Console 22 ! Problems () Debug Shell T Properties ks Base64 String Decoder

Process Launcher eX% &EREE vy =n0

This opens a dialog where you can select a folder in which the Gold input file is to be

created.
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9 Select folder

Select folder

>

o

v @ Application.module

= settings
= WebResources
= META-INF
= Policies
= Processes
= Resources
= Schemas
= Service Descriptors
= target
= Tests
= MockFiles

@

New Folder...

OK Cancel

o Note: Linearize the copied XML data if required.
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Working with a Test Suite

The Test Suite feature provides a functionality to run set of test cases when running the

test goal.

Adding a Test Suite

Before you begin

» Ensure you have added Unit Test Assertions. For more information, see Adding Unit

Test Assertions.

Procedure

1. Right-click the Test folder and select the New > Add Test Suite option.

b Design - TIBCO Business Studio for BusinessWorks(TM)
File Edit MNavigate Search Project Run Window Help

BvE@e =% GASOGM-HvO~

[& Project Explorer £
O bw6-maven-plugin
v & UnitTestDemoProject [AppSpace]
> <3 Processes
[F Service Descriptors
» (& Resources
+ g Schemas
[®l Policies
- & Module Descriptors
2T
& t
& b
Mp &
> % Uni

= Unit

New

Go Into

Copy

Paste

® Delete

@ Copy

Paste BW
Special Folders
Move...

Rename...

I= =>| P T =0

Ctrl+C
Ctrl+V
Delete
Ctrl+C
Ctrl+V

F2

>

Project...
¢ File

& Folder

SQL File

Add Test Suite
Add Test File

BE @

a

Example...

% Other... Ctrl+N

The Test Suite wizard is displayed.
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Note: You can also create a Test Suite in the subfolder created under the
Tests folder.

2. In the Test Suite wizard. Provide the name in the Test Suite Name field. Click Finish.
#D New Test Suite O X
Test Suite
Create a new Test Suite
Select parent Test folder and target file name:
Test folder: | LJnitTestDemoProject/Tests
Test Suite Name: ; TestSuite2.bwts
®
The test suite is added to the Test folder.
3. Open the test suite in the Test Suite Editor window.
ELN"III « U B 0P o i T L St bt + TIOC O Beninris Soudlio o Busissmavorial ) - o x
de Bl Navigile Seich Pojedt Run Wiedow Help
[ - L BRSGIMT S QTR TS . (G Access || 1| i Design © Doy
e — 3 D IS ubetbets = -
\:;::‘r:wm * | Test Suite Edmor
1. - o
G
2 ki ot
£ SbPrecesithA S Assotion st bl
! ?M«f::-:“wli“fﬂvllﬂl‘oll-ﬂ'.ml
e
= Rt Souvce
B Uit bstDemofresectapploation [Aootpacs 1 Progerties & Problews | B Help © Consale 1 T Call Hetmdly + Seasth
© Usit bsaDamolvopect apebcation gaent v | No conaoles to diplay ot ths Sme.
¥ O 7t BAP. SO, B 0. ©Mo., UL,

4. To add test cases in the test suite, click Add.
5. Select the test case. Click Ok.

To add multiple test cases, use the Ctrl key and click multiple test cases.
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@ Choose Test Case File Name

¥ @ UnitTestDemoProject
v = Tests
B ActivityAssertionWithGoldFile.bwt

El FaultlLogicTest.bwt
SubProcessWithActivityAssertionTest.bwt
B SubProcessWithPrimitiveAssertionTest.bwt

Cancel

OK

6. To remove a test case from a test suite, select the test case and click Remove.

Running a Test Suite

1. To run a test suite, use the property testSuiteName to pass the test suite name while

Procedure
running the test goal.

Test Suite Name%

—0s
=%

For example:

test -DtestSuiteName
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test -DtestSuiteName=ActivityAssertionTestSuite.bwts

2. To run multiple test suites in a sequence, provide the test suite names separated by

For example:

test -DtestSuiteName=%TestSuiteNamel%;%TestSuiteName2%

test -
DtestSuiteName=ActivityAssertionTestSuite.bwts;FaultTestSuite.bwts

a Edit Configuration

Edit configuration and launch.

Name: | Applications.parent (7)

ElMain = JRE " Refresh| % Source B Environment| = Common

Base directory:

‘ ${project_locApplications.parent}

Workspace... File System...| |Variables...

Goals: | test -DtestSuiteName=testSuite\TS 1\TS2\ TestSuite2.bwts;testSuite\TestSuite1. bw‘ts| |
Profiles: |

User settings: | C\Users\rdeo\.m2\settings.xml

Workspace... File System...| |Variables...
|:| Offline D Update Snapshots

[1nahua Moot [ Slin Tacte [ Nan-racturcia

Revert Apply

@

Note: If you are running a test-suite present under the sub-folder of the

Tests folder, then you need to provide a path of the suite from the sub-
folder.

Adding Mock Support for Activities

This section provides steps for adding mocking support for ActiveMatrix BusinessWorks
activities with TIBCO ActiveMatrix BusinessWorks™ Plug-in for Maven. You can skip
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execution of an activity (usually activities that are based on external service) whose process
is under Unit Testing. Mocking support functionality is required mainly for the ActiveMatrix
BusinessWorks activities that are based or dependent on some external Cloud Service or
Database systems, which are eventually under Unit Testing. To run Unit Testing
successfully on processes that contain the ActiveMatrix BusinessWorks activities, we need
to mock the ActiveMatrix BusinessWorks activities. Now a dummy output can be added to
mock activities that can be used in Unit testing for successful execution. The mocking
support can be used to mock the activities from processes or sub-processes.

Adding Mock Output to an Activity

To add mock output to an activity in ActiveMatrix BusinessWorks, follow these steps:

Procedure
1. Right-click on the module project and select New > Tests Folder.

The Tests folder is added in the module project.

[P etoatmtroces P UTDRE i etmtt oegs - THCE Botinoss Sk ot Rl OAETLS - EN o utoetamert e —

fe £t Duagram Kavgie Sewch Proea Ren Window Help
2 LA Uve-Ovivsy~ % felevawes
e L 0] e v |rd vy Bl vick A || o E
Er— 1% 7 T —r—
% 208CMod | e T Peejet I et EWACSTh Froes S el
RO Gante 2 Terts Foider ATE
& Copy i€ B BusnessWorks Appleatien Modue ° 'ﬁ - s -u i}
ste B Cutey B BusiressWorks Shared Modale Saa DRy Mapar End B
LIk Delebt @ BosinapriVoris Agpication, Farite .
NS 2 Beslraorks RIST Rescurco Pabta L =
Impart Vg B
Export P ekl fanie
© Rufash Fs B SOERe Adtivitas
Chse Freseet = gl -
Chnse Unielsted Projects T Ot e i
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Cutine @ Punds P b Pl Eapoier. © 0| Siivoparion 17 I Probilre [ BW Halp O Comste =
Team ' | o
% JDBCMockProgect -
Dlbcmadk  Comgone Wes e
Pestare fromLocal Histony.. Ressares VRSN Vst
. » Irfo -
D‘:‘ ..... y Viscslies *‘ . ot
L 5 st modified My 27, 2079 8 100217 A
Phaginfeals s S oy
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Sowce y name JDFCM ek Project
= Show froperties View < e A ,
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2. In Project Explorer, right-click on the Tests folder and choose New > Add Test File.
If needed, change the name of the Test file. Click Next.
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The New Test File wizard is displayed with a list of processes and subprocesses.
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3. Select the process or subprocess having the activities to be mocked.

4. Right-click on the activity to mock and select the Add Mock To Activity option.
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The new Tests tab is added in the property section of the activity.

5. The new Tests tab has a file selector to select the output file. Select the output file

using File Selector.

' Project Explorer & ES Y
[ JDBCMockProject [BW6 AppSpace]

o1¢ build.properties

P
g
§

= O |4 JDBCSubProcess.bwp X |

JDBCuer) Mapper

@@

<. Palette
> @Processes Ej tibco.bw.sample.palette.jdbc.basic.JDBCSubProcess N - '
[5 service Descriptors [\\‘ = 4 g
> {2 Resources [ﬁh.
> {#@Schemas

| 'BlPolicies _ Recently Used <
> & Module Descriptors | Favorite Palettes <
> @Tests

C—a-=—0

#: tibco.bw.sample.palette.jdbc.Basic.application [BW6 AppSp: Start

End

© @ -
Mapper Notify
= outl E2API ®4cClo [ File 32 @ Mod fDep = O [ Properties 2 [2! Problems (2) BW Help & Console ) @ 8 =0
. & =E®®E § 5 JDBCQuery (JDBC Query)
> (= conversation £
> @ source Description Test File:
> [=binding Statement
> [=scenario Reianaed Mock Output File: Q E:@
> = bwTemplate Tags
> [Z UnitTesting 25
> = policy
v [Zpalette Input
> e Output
> [=file
> & mail Fault
[Ziava

= 8
>

Palette Library <«

@ 3

Basic Activities

|
File i

. General A... 2
N bl a
Inspector Log

6. In the Mock Output File field, browse and select the file from the workspace. The

path of the Mock output file can also be set using Module properties.
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Running Unit Tests in TIBCO Business Studio for

BusinessWorks

Follow these steps to run unit tests in TIBCO Business Studio for BusinessWorks.

Procedure

1. In TIBCO Business Studio for BusinessWorks, right-click the.application file and

select Generate POM for Application.

B Ik od (G Genoeata POM For Application D ®
b Edit Diagram Navigats Soad
LA = | Maven Configuration Details for Plugin Code lor Apache Maven and TIBCO BusinessWorks(TM)
o L Enties the Grouptd and Astifectisd for Maven POM Fle genesation. I Design
, Progect Explorar 7 PO dikes ol ba genarated for Projacts Ested balow and Parpet POM fia wil be ganerated aggrageting the Prajects = g
% IDBCModRjecl [Aopapace) | ote® : Maven Artifectid and Borede- Symbolichiame should be seme. I A | Palatte
 IDBCMockProectapglication | Mot : Maven Version and Bundle-Virsion should be same. L& &
Group id: o tiber b Rt
Puserd Autifect 18 [avantn b Bunlo sl Racently ..
Wershon: 1AL M AR Faneeeite .
Paletts L
Mote" ; Tilco Home and BW Harme vakues are required to run the Unit-Tasts defined in the Project
=
Skip Tosty: 1
ool -
Fad if Mo Tests e Athvities
TibeoHome : [Tiken-meeas s |
W Harme. preere| Fle
Deplay Optians: | Hone v
FIe
Boote® : The POM File will b gemesatecl fupdates] f exiits) foe foliowing Projecs.
Outine | & AP Expl, B3 Cloud | | Module Mama Whodule Type Artifactid -
| | ID8CMockPeojoct Applcetion Applicotion  IDBIMonPicject applicaticn
= @ [hemackpeosat IDBC SubProg A0S b daal il ik s Al P A o)t - -
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 References
¥ G Acthaties
O Sast B s
0 ind
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¥
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2. Verify the TIBCO_HOME value and click Finish.

For example, C:\tibco\bw651 for Windows. Set BW Home as the relative path to the
version-specific BW folder under T/IBCO_HOME (with a leading slash and no trailing

slash), for example \bw\6.5 for Windows.

It converts the existing projects to Maven type and adds a new project called
*.application.parent, then creates pom.xml files in all projects.
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3. Right-click the parent project and run a "test" goal.
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To run the Maven goals,
Maven build.

right-click the .parent application, and select Run As >
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File Edit Diagram Navigate Search Project Run Window Help
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5. Provide the Maven goal in the Goals field that is to be executed, then click Run.
O <

9 Edit Configuration

Edit configuration and launch.

MNarme: | AppVersion.parent (1)

= Main| =i JREl & Refreshl - Source | ™ Environment T Common
Base directory: =
| ${project_loc:AppVersion.parent} |
Workspace___. File System___. Variahles___.
IGoaIs:I sitel |
Profiles: [ |
User settings: I ChUsers\apps\.m2\settings.xml |
Workspace... File System... |Variab|es...
[ offline [] update Snapshots
[l Nabua Outred [ 1 Slin Tacte [ 10 sechin |
Rewvert | Apply
@ Run Close

Generating Mock Output File

To generate the mock output files in TIBCO Business Studio for BusinessWorks, follow

these steps:

Procedure

1. Run the application in Debug mode from TIBCO Business Studio for BusinessWorks.

The Debug perspective is displayed.
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2. In the Debug perspective, select the Output tab from Job Data view for an activity
whose mock output file is to be generated.

3. Right-click the activity name on the Output tab and select Generate Mock Output

File.

(=R d w | -

Seqoe Ul

Deb.. ©Proj.. #Serv..
b L

v %l app.module.Process

% Busi... ¥

File Edit Diagram Navigate Search Project Run Window Help

&
9 B
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e e e

2023-10-06T12 06,329 INFO [main] com.tibco.bw.frwk.engine.BWEngine - TIBCO-BW-FRWK-300082: BW Engine [Main] started successfully. o)
2023-10-06T12:33:06,579 INFO [Framework Event Dispatcher: Equinox Container: a9e9704d-8f31-473c-9c8c-d18bd7594916]
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com.tibco.thor.frwk.Application - TIBCO-THOR-FRWK-300018: Deploying BW Application [app:1.0.8].

2023-10-06T12:33:06,827 INFO [EventAdminThread #13] com.tibco.thor.frwk.Application - TIBCO-THOR-FRWK-360019: BW Application
[app:1.0.8] is impaired.
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com.tibco.thor.fruk.Application - Started by BusinessStudio, ignoring .enabled settings.

2023-10-06T12:33:10,019 INFO [Job_Executor@] com.tibco.thor.frwk.Application - TIBCO-THOR-FRWK-300021: All Application dependencies
are resolved for Application [app:1.0.0]

2023-10-06T12:33:15,009 INFO [EventAdminThread #4] com.tibco.thor.frwk.Application - TIBCO-THOR-FRWK-300006: Started BW Application
[app:1.0.0]
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This opens a dialog where you can select a folder in which the Mock output file is to

be created.

4. Services like REST and SOAP can have multiple variables. So in the job data, the
output is shown for multiple variables. In this case, append the file for each variable

data.
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Limitations for Mock Support

The following are the limitations for Mock Support in TIBCO Business Studio for
BusinessWorks.

o ActiveMatrix BusinessWorks needs to be installed on the same server where the tests
are to be run.

* Unit Tests can currently only be invoked with Maven.

Adding Mock Fault to an Activity

This document provides steps to add Mock Fault for activities in ActiveMatrix
BusinessWorks with the Maven Plug-in. You can also mock faults generated by activities
and test the exception handling logic, and test all the transitions.

Before you begin
e Activities to be mocked must be present in a process or subprocess included under
Unit testing.

» Generate a valid Mock Fault file. For more information on generating the mock fault
file, see Generating Mock Fault File.

Make sure the demo project with the process or subprocess that has faults to be mocked,
is created.

To add a mock fault to an activity in ActiveMatrix BusinessWorks, follow these steps:

Procedure
1. Right-click on a module project and select New > Tests Folder.

The Tests folder is added in the module project.
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In Project Explorer, right-click on the Tests folder and choose New > Add Test File.

If needed, change the name of the Test file and click Next.
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The New Test File wizard with a list of processes or subprocesses.
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Select the process or subprocess which having the activities fault to be mocked.

Right-click on the activity to mock fault and select the Add Mock Fault To Activity
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The new Tests tab is added in the Properties section of the activity.

5. The new Tests tab has a file selector to select the mock fault file. Select the mock
fault data file using the file selector.

You can provide the relative mock fault file in the Mock Fault File field.
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To run Unit Tests in TIBCO Business Studio for BusinessWorks, see Running Unit
Tests in Studio.

Generating Mock Fault File

To generate the mock fault files in TIBCO Business Studio for BusinessWorks, perform the
following steps:

Procedure

1. Run the application in debug mode from TIBCO Business Studio for BusinessWorks.

The Debug perspective is displayed.

2. In the Debug perspective, select the Fault tab in the Job Data view for a faulted
activity for which the mock fault file is to be generated.

3. Right-click on the activity name on the Fault tab and select Generate Mock Output
File.
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This opens a dialog where you can select a folder in which the Mock fault file is to be
created.

Limitations for the Mock Fault Support

The Mock input feature has the following limitations in TIBCO Business Studio for
BusinessWorks.

e ActiveMatrix BusinessWorks must be installed on the same server where the tests are
to be run.

e Unit Tests can currently only be invoked with Maven.

Adding Mock Support to SOAP and REST
Service Binding

This document provides steps to add Mock Input to SOAP and REST Service Binding in
ActiveMatrix BusinessWorks with the Maven Plug-in. To mock a Service Binding, mock the
respective operation and then the corresponding job flow gets run with mock input while
running the test case. If a Service has multiple operations, a test file must be created for
each operation and then add the mock input accordingly to test each flow associated with
the operation.

Before you begin
e Service Binding to be mocked must be present in a process under Unit testing.

TIBCO ActiveMatrix BusinessWorks™ Maven Plug-in




44 | Unit Testing

» Generate a valid Mock Input file. For more information on generating the mock input
file, see Generating Mock Input File.

Ensure the demo project that has the service to be mocked, is created.

To add mock input for service binding in ActiveMatrix BusinessWorks, follow these steps:

Procedure
1. Right-click a module project and select New > Tests Folder.

The Tests folder is added in the module project.
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2. In Project Explorer, right-click on the Tests folder and choose New > Add Test File.
If needed, change the name of the Test file and click Next.
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3. Select the process or subprocess having the service to be mocked.

4. Right-click on the operation to mock and select the Add Input option.

| resourceproject.ResourcePost
> 0 @ & 0>
- J = P <rfzho -
[,?ﬂ?ﬁ = | | 2] resourcepost/post| b2 =
*Z] post = 5
e File > | i
. .
@ Quick Fixes > ()
# Operation > postOut
= (reate Skeleton Interface
® Refactor » —
£+ Debug BusinessWorks Applications
#2| Run BusinessWorks Applications ))
Edit >
) Add Note
o Add Test > <= Add Input
Bt 5 Delete Input
& Help >
M Validate
B Show Properties View
Properties
& Console [£l Problems [3) Debug Shell 4" Search [S Properties 2 [m Base64 String Decoder Process Launcher 3e Call Hierarchy
Operation
~ [¥ Operation Input ~ i
el IzlPE - P! Operation Input
e e pos?t equest v [ Operation Input
- ~ [P item _ [ postinput (postRequest)
DUt Bt string 7 item (Primitive Type: string)
_Fault ~ [ httpHeaders ~ [ httpHeaders (Element: httpHeaders)

TIBCO ActiveMatrix BusinessWorks™ Maven Plug-in



46 | Unit Testing

The new Tests tab is added in the Properties section of the activity.

5. The new Tests tab has a file selector to select the mock input file. Use the Input XML
File field to select the mock input data file using the file selector.
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To run Unit Tests in TIBCO Business Studio for BusinessWorks, see Running Unit
Tests in Studio.

Generating Mock Input File

To generate the mock input files in TIBCO Business Studio for BusinessWorks, perform the
following steps:

Procedure
1. Run the application in debug mode from TIBCO Business Studio for BusinessWorks.

The Debug perspective is displayed.

2. In the Debug perspective, select the All tab in the Job Data view for the operation for
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which the mock input file is to be generated.

3. Right-click on the operation name on the All tab and select the Select All option.
Then select Generate Mock Output File.
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This opens a dialog where you can select a folder in which the Mock input file is to be
created.

Limitations for the Mock Support to SOAP and REST
Service Binding

The Mock input feature has the following limitations in TIBCO Business Studio for
BusinessWorks.

e ActiveMatrix BusinessWorks must be installed on the same server where the tests are
to be run.

e Unit Tests can currently only be invoked with Maven.

o Note: For mocking SOAP Service Binding with HTTP transport, the HTTP
connection must be pointed to an unoccupied port or localhost.
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Adding Mock Support for Process Starter

Now you can add the Mock Input to the Process Starter in ActiveMatrix BusinessWorks 6.8.0
with Maven Plug-in 2.9.0. You can skip the execution of a Process Starter by adding the
Mock Input to the Process Starter, whose process is under Unit Testing. The Assertion
support is not provided to the Process Starter, because Process Starter creates ActiveMatrix
BusinessWorks jobs continuously and they are dependent on the third party. The Unit
Testing is specific with a single job only, so there is no need to add the assertion to the
Process Starter. Hence, only the Mock Input support to the Process Starter is provided.

o Note: When you want to test the activities from the Main Process, it is
recommended to mock the Input of Process Starter.

Before you begin
e Process Starter to be mocked should be present in the process, which is under Unit
Testing.

» Generate a valid Mock Input XML file. For more information, see Generating the Mock
Input File.

Procedure

1. Right-click the module project and select New > Tests Folder. This adds the Tests
folder in the module project.
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2. Right-click the Tests folder in the Project Explorer pane and select New > Add Test

File. Change the test file name if required and click Next. This shows the New Test
File wizard with a list of available processes.

3. Select the process having the Process Starter to be mocked.
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4. Right-click the Process Starter to mock, click Add Test > Add Input.
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The Tests tab is added in the Properties section of the activity. The Tests tab
contains the Input XML File option to select the path of the Mock Input XML file. The
path of the Mock input file can also be set using Module properties.
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Generating the Mock Input File

To generate the Mock input file, perform the following steps:

Procedure
1. Run the application in the debug mode from TIBCO Business Studio for
BusinessWorks.

2. Select the Output tab from the Job Data for Process Starter for which the Mock input

file is to be generated.

3. Right-click the activity name in the Output tab and select the Select All option to

select all the data. Then select Generate Gold Input File.
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4 Debug & Project E.. * Servers % Business.. @ O @ Process.bwp % & JMSConnectionResource jmsConnResource = 0 oVari.. %Bre.. ¥ Exp.. XJo.. % WAss.. BDe.. O

BB

= N Val
v 4%l application.module.Process reoontl Output a':fw — a“f» e
+ @ application.module Process [bw0a101] - (Viewed cently — aminsm
% JMSReceiveMessage [bw001g1.3] - (Done) R o Favorite ...
» Confi _ Tl g e T Palette Li... ¢ @ Copy Values
Confirm [bw001g1.4] - (Done) 13 P = :
y [ ® Copy Variables
= Log [bw001g1.5] - (Done) IMSReciven Confi . 0]
eceveres - ontirm 9 Basic Activities | El Generate Gold-Input File...
- [ Generate Mock-Output File...
File
W L

I vNve=0o

This opens a dialog where you can select a folder in which the Mock input file is
created.

Limitations for Mock Process Starter

The Mock Support for Process Starter feature has the following limitations in TIBCO
Business Studio for BusinessWorks:

to be

e ActiveMatrix BusinessWorks must be installed on the same server where the tests are

to be run.

e Unit Tests can currently only be invoked with Maven.
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Running ActiveMatrix BusinessWorks Design
Utility Goal

The bwdesignUtility Maven goal provides a command-line interface to validate the
ActiveMatrix BusinessWorks project and generate the process diagram.

Assuming that the user already has the ActiveMatrix BusinessWorks Unit Test Project with
POM generated and includes a valid TIBCO_Home and BW_Home, follow these steps to run the
bwdesignUtility goal:

Procedure
1. Navigate to the ActiveMatrix BusinessWorks unit test parent project workspace and
open the command prompt or Git Bash.

2. To validate the ActiveMatrix BusinessWorks project, run the bwdesignUtility goal by

passing the commandName argument with value validate in the following way:

mvn com.tibco.plugins:bw6-maven-plugin:bwdesignUtility -
DcommandName=validate
This validates the project.
3. To generate the process diagram for the project, enter the bwdesignUtility goal by

passing the commandName argument with value gen_diagrams in the following way:

mvn com.tibco.plugins:bw6-maven-plugin:bwdesignUtility -
DcommandName=gen_diagrams

This generates a process diagram in the Resources folder of the ActiveMatrix
BusinessWorks application project.

4. To generate the Manifest JSON file from the project whose deployment target is
TibcoCloud, enter the bwdesignUtility goal by passing the commandName argument
with a value generate_manifest_json in the following way:

mvn com.tibco.plugins:bw6-maven-plugin:bwdesignUtility -
DcommandName=generate_manifest_json

This generates the manifest JSON file in the ActiveMatrix BusinessWorks application
project.
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o Note: This goal is available from Maven Plug-in version 2.8.1 onwards.

5. To validate the ActiveMatrix BusinessWorks project, generate the process diagram

and the manifest JSON file for the project sequentially, run the bwdesignUtility
command without passing an argument commandName.

mvn com.tibco.plugins:bw6-maven-plugin:bwdesignUtility

Using Custom Xpath Functions with
TIBCO ActiveMatrix BusinessWorks Plug-in for
Maven

To use custom XPath function with TIBCO ActiveMatrix BusinessWorks Plug-in for Maven,
perform the following steps:

Procedure

1

Create a custom XPath function project with ActiveMatrix BusinessWorks. For more
information, see "Creating Custom XPath Functions" in ActiveMatrix BusinessWorks
Bindings and Palette Reference.

Create a sample BW application using the custom Xpath function created in Step 1.

In the Project Explorer, ensure that the custom xpath function project is added in the
Includes application.

To generate the POM files, right-click the project and select Generate POM for
application. The parent pom.xml project must list down all the modules as below:

<modules>
<module>../CXFDemo</module>
<module>../CXFTest.module</module>
<module>../CXFTest</module>
</modules>

Add the cxf common extension dependency in the custom XPath function pom.xml
project.
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<dependencies>
<dependency>
<groupId>com.tibco.plugins</groupId>
<artifactId>com.tibco.xml.cxf.common</artifactId>
<version>${cxf.common.version}</version>
<scope>provided</scope>
</dependency>
<dependencies>

Note: Replace the ${cxf.common.version} with version available in the
BW_HOME. For example, 1.3.400.

6. Create a maven run configuration. Select the BW application parent project as the
base directory.

7. Provide the maven goal clean Test.

8. To generate the EAR, provide the Maven goal clean package.

The BW application must have unit tests defined. For more information, see Unit Testing.

Using External Custom XPath Function with
TIBCO ActiveMatrix BusinessWorks Plug-in for
Maven

To use an external custom XPath function with ActiveMatrix BusinessWorks, perform the
following steps:

Procedure
1. Create a custom XPath function project with ActiveMatrix BusinessWorks. For more
information, see "Creating Custom XPath Functions" in ActiveMatrix BusinessWorks
Bindings and Palette Reference.

2. Right-click on the created project and select Generate POM for CXF Project. This
mavenizes the project and generates a pom.xml for the custom XPath function
project.
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L’D Project Explorer & ES T |6+ 8 =08
v =% cxfpre
5 = R New >
s B Pl Go Into
> B sr( Show In Alt+Shift+W >
BM g copy Ctri+C
[ 4
> & 0% = paste BW Ctri+V
ut BL 3¢ Delete Delete
@ pl Rename...
Import >
Export >
2| Refresh E5

Close Project
Close Unrelated Projects

EZ Remote Interface >
Generate POM for CXF Project
@ RunAs >
% Debug As >
Profile As >
Restore from Local History...
Dependency Visualizer >
Team b
= Qutline Compare With ” i @ Module & DeploymentSer.. = O
Plug-in Tools >
There is no Cophyme :
Source >
b Validate

[C] Show Properties View
Properties Alt+Enter

3. Create a Run or Debug Configuration for Maven. Select the custom Xpath function
project and run the clean install goal. This installs the custom XPath function
project in the local .m2 repository.

4. Open a new eclipse workspace. Create an application project and to generate the
POM for the application, right-click the application and select Generate POM for
Application.
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[P New folder - Demo/META-INF/MANIFEST.MF - TIBCO Business Studio for BusinessWorks(TV)
File Edit Navigate Search Project Run Window Help
Dr-HeRGRAS OB M ikvO~ QU i®y i
Koo Project Explorer 52

> & Demo [BW6 AppSpace]

> ¥ Demo.application [BW6 AppSpacel
New >
Go Into

Show In Alt+ShiftsW >

Copy
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Rename...

crl+C
cl+v
Delete

x

Import >
Export >

Refresh

Close Project

Close Unrelated Projects
Create Enterprise Archive (EAR)
Deploy Application..

Generate POM for Application
Run As )
Debug As >
Profile As >
Restore from Local History...
Dependency Visualizer
Refactor

Team

Compare With

Configure

Source

Validate

# 0

8 Outline 52 2 API Explo =&
%3

Deployment Ser...

2 Overview

[2 Module Properties
[2 Dependencies

[ Components

[2 Shared Variables

Show Properties View
Properties

Alt+Enter

& Demo.application -

Ovenview| Module Properties| Dependencies| Components| Shared Variables| MANIFEST.MF| module.owm|

N X
P e v v|mig Q s|g
= o
@ Overview 0%

General Information Module Content

This section describes general information about this BusinessWorks Module. The content of the module is made up of four sections:

D: [ Demo ] Module Properties: lists module properties and profiles.
Version: ‘ 1.0.0.qualifier ‘ D : lists all the modules required on this module’s classpath to
Name: [ Demo Module | ol S
Vendor: [T18C0 Software i ] Components: lists the components that make up this module’s runtime.
Shared Variables:
Module Type: | Applcation Mo 7 red Variables:lists module and job shared variables.
Description: [ | E—r—
prefixes.
Getting Started

Configure namespace registry
Getting started with the links to build BusinessWorks package and process.

@ Create a BusinessWorks Process Package
@ Create a BusinessWorks Process
@ Create a BusinessWorks Sub Process

Testing

Test this module by launching a separate BusinessWorks Runtime:
O Launch

[ Properties BW Help & Console £

BW6.8.0VS5\tibcojre64\1

22 Problems @ EX% EREE -0
D

14-Jan-2022, 7:18:12 PM)

5. Open the Application Module pom.xml and add the custom XPath function project
dependency, which is present in the local Maven repository, and save the pom.xml.

D New fo

file Edit Navigate Search Project Run Window Help

O~ RSAROR N -0~ U~ BF P OIENE
B% V&SP

Demo/pomxml -

BCO Business Stu

o for Busine:

[¢5 Project Explorer

~ @ Demo [BW6 AppSpace]
> < Processes

[ Service Descriptors

4 Resources

@ Schemas

81 Policies

& Module Descriptors

(s build.properties

B pom.xml

~ ¥ Demo.application [BW6 AppSpace]
> % Package Unit

[ pom.xmi
> 5 Demo.application.parent

£ Outline 52 =2 API Explorer =4 Cloud Applicatio.. = File Explorer @ Module & Deployment Ser...

22 xml

> <> project oc: P

2|5 ;igrail

£ =

b
»

#) Select Dependency

3

x| 53

Filter.

1% % 0 3p  Dependency Management

Version: [ 1.00-SNAPSHOT| | scope: |compile | | Add
Remove
Enter groupld, artifactid or sha prefix or pattem (*)
| Properties
| Managt
& Index downloads are disabled, search results may be —
incomplete.
Search Results:

b Dependency Hierarchy page:
[ pomxmi|

\

Cancel

ource Path Location Type

he.org/POM/4.0.0 http:

‘maven-

The CXF project is displayed in the

Project Explorer.
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10.

#) New1 - Demo/pom.xmi - CAUsers\xyz\workspace\681V12_1\New - TIBCO Business Studio for BusinessWorks(TM) - X
File Edit Navigate Search Project Run Window Help
o |SROLRGAS| MryivOvRvi®@yvih vivodovyDv|m Q ||
& Project Explorer E%V[%4 % =5 &pemo/pomxml & =0
= — "
|f°dp'° T jar) Dependencies Fiter:| 8¢
s Demo
@ Demo.. v Dependencies 1% & W3  Dependency Management 1 w35
& Demoapplication.parent 0 com.tibco.bw.palette.shared : 6.2.1300 [provided] Add...

O axfpro : 1.0.0-SNAPSHOT Remove

Properties.

Manage...

To manage your transitive dependency exclusions, please use the Dependency Hierarchy page.
Overview| Dependencies| Dependency Hierarchy| Effective POM| pom.xml
E0. = 2A. #Hd. HFfi. @M. BD.. ~ Y DPproperties 2 @BW Help @ Console &g =0
e §
22 xml

¢ project xsi:schemalocation=http://maven.apache.or ""oPerties are not available

Note: The icon changes for the custom XPath function project indicating
the project is referenced and is not in the workspace.

To start using the custom functions in the BW project, right-click the CXF project and
select the Install CXF Project option.

The BW application must have unit tests defined. For more information, see Unit
Testing.

Create a maven run configuration. Select the BW application parent project as the
base directory.

Provide the maven goal clean Test.

To generate the EAR, provide the Maven goal clean package.

Using Shared Modules with TIBCO ActiveMatrix
BusinessWorks Plug-in for Maven

To use shared modules with the TIBCO ActiveMatrix BusinessWorks Plug-in for Maven,
perform the following steps:

Before you begin
Ensure that a shared module project is created in the workspace.

Procedure
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1. Create an application project Sample and a shared module Logging and refer the
subprocess from the shared module in the application module.

2. To generate the POM files, right-click on the project and select Generate POM for
application. The wizard lists down all the shared modules referenced by the
application.

Note:

- POM files will be generated for Projects listed below and Parent POM file will be generated aggregating the Projects.
- Maven Artifactld and Bundle-SymbolicName should be same.

- Maven Version and Bundle-Version should be same.

- TIBCO Home and BW Home values are required to run the Unit tests defined in the Project.

Group ld: [ com.tibco.bw I

Parent Artifact Id { Sample.parent I

Version: 1.0.0-SNAPSHOT

Unit Test Configuration :
Skip Tests: ]
Fail if No Tests : ]
TIBCO Home : | C\tibco_bw6.7 |
BW Home : [ \bw\6.7 |

Engine Debug Port: | 8090
Deploy Options:

Selected Projects :

Module Name Module Type Artifactld
Sample Application Sample
Sample Module AppModule Sample.module
Logging Module Shared Module Logging

The parent pom.xml project lists down all the below modules:

<modules>
<module>../Logging</module>
<module>../Sample.module</module>
<module>../Sample</module>
</modules>

If a new shared module is added after mavenizing the project, open the Generate
POM for application wizard again to regenerate the pom.xml files.
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Using External Shared Modules with
TIBCO ActiveMatrix BusinessWorks Plug-in for
Maven

Note: The following steps are also applicable for using Binary Shared Modules
with ActiveMatrix BusinessWorks Plug-in for Maven.

To use external shared modules with ActiveMatrix BusinessWorks, perform the following
steps:

Procedure
1. Create a shared module project with ActiveMatrix BusinessWorks.

2. Right-click the created project and select Generate POM for Shared Module. This
mavenizes the project and generates a pom.xml for the shared module.

3. Create a Run or Debug Configuration for Maven. Select the shared module project
and run the clean install goal. This installs the shared module project in the local
.m2 repository.

4. Open a new eclipse workspace. Create an application project and to generate the
POM for the application, right-click the application and select Generate POM for
Application.

5. Open the Application Module pom.xml and add the shared module dependency,
which is present in the local Maven repository, and save the pom.xml.
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Dependencies

Dependencies

{ Group Id:

* com.tibco.bw

|| Artifact Id: « LoggingModule

) com.tibco.bw.palette.shared : 6.1./

To manage your transitive dependency ext

Overview Dependencies D-pand‘m;‘
{

Version: | 1.0.0-SNAPSHOT|

=8
Select Dependency

Filter:
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Scope: compile [} Add...
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Search Results:
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>

Cancel

# |05 Design
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The shared module project is displayed in the Project Explorer.

o Note: The icon changes for the shared module project indicating the
project is referenced and is not in the workspace.

2

Running Test Cases from an External Shared Module

To run test cases from an external shared module, perform the following steps:

1.

Right-click the parent project in which the module is added as a POM dependency
and select Run As > Maven Build.

In the Edit Configuration wizard, configure the goals to achieve the following

scenarios:

Scenarios

Run Test
Cases from
the External
Shared
Module that
are added
as

Using Studio

test -DrunESMTest=true

Using Command Line

mvn test -DrunESMTest=true
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Scenarios Using Studio Using Command Line

POM depen
dencies

Run Test test -DrunESMTest=true - mvn test -DrunESMTest=true-
Suites from DESMtestSuiteName="testSuitel.o  DESMtestSuiteName="testSuitel.b
the wts wts"

External Sha

red Module

”»

Run Multiple test -DrunESMTest=true - mvn test -DrunESMTest=true-
Test Suites DESMtestSuiteName="testSuitel.o  DESMtestSuiteName="testSuitel.b
from the wts;testSuite2.bwts” wits;testSuite2.bwts"

External

Shared

Module

Generate site -DrunESMTest= true mvn site -DrunESMTest=true
BusinessWo

rks

Coverage

report

Limitation

If the Test Case from the External Shared Module fails while using the above mentioned
method, you should import the Shared Module Project into the Workspace. Then change
the fault data and publish it in the .m2 repository and run the test case again.

It is expected that you should test the External Shared Module while it is being developed,
by creating a dummy application and adding the shared module dependency in it. Run the
test goal on the parent project that can run the test cases from the Shared Module as well.

Dependency Exclusions

To exclude dependencies that are not used in the project, Maven supports dependency
exclusions. You can set exclusions on a specific dependency in your POM file. For example,
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<medelVersion>4.0.8</modelVersion>
v<parent>

<groupIdscom.tibco.bw/grouplds
<artifactId>MainApplication.parent</artifactId>
<version>1.@.0-SNAPSHOT</version>
</parent>

<relativePoths. . /Hainspplication.parent</relativePaths

<artifactId>Mainapplication.module</artifactlds
¥ <dependency>

v<project xmlns="http://maven.spache.org/PON/4.0.2" xmlns:xsi="http://uum.u3.0rg/2001/XLSchema-instance” xsi:schemalocation="http://maven.apache.org/POM/4.8.6 https://maven.apache.org/xsd/maven-4.8.0.xsd">
<packaging>bumodule< /packaging>
v <dependencies>

<groupId>com. tibco. plugins</grouplds
<artifactId>com.tibco.bw.palette.shared</artifactld>
<version>6.2.1308</version>
<scope>provided</scope>

<

¥ <dependency>

<groupId>com. tibco. bu</groupldy
<artifactId>ProjectB</artifactId>
<version>1.8.8</version>
v <exclusions>
v ¢exclusions

<groupId>com. tibco.bw</groupId>
<!-- Exclude Project-D from Project-B
<artifactId>ProjectD</artifactld>
</exclusion>
</exclusions>
</dependency>
¥ <dependency >

<groupId>com. tibco. bw</groupld>
<artifactId>ProjectC</artifactId>
<version>1.8.8</version>
</dependency>
</dependencies>
¥<build>

<seurceDirectory>src</sourceDirectory>
¥ <plugins>

<outputDirectory>target/classes</outputDirectory>
v<plugin>

<groupId>com. tibeo.plugins</groupld>
<artifactld>bwé-maven-plugin</artifactlds
<version>2.9.4</version>
<extensions>true</extensions>
</plugin>
</pluginss

</build>

</project>

Note:

» Dependency exclusions are to be used when you generate an EAR using
the Maven install or package goals.

» Support for dependency exclusions is provided on the top-level POM.
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Deploying EAR Using Maven

Before you begin
e Ensure that the TIBCO® Enterprise Administrator is up and running with the

registered BWAgent.

To deploy EAR on AppSpace via TIBCO Business Studio for BusinessWorks, perform the
following steps:

Procedure
1. Right-click a .parent application and select Generate POM for Application. The

Generate POM for Application dialog opens.

2. To set Deploy Options, select AppSpace from the dropdown list while generating
pom.xml. Then click Next.
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ﬂ Generate POM for Application O

Maven Configuration Details for TIBCO BusinessWorks(TM) Application
Enter the Groupld and Artifactld for Maven POM File generation.

Note :

- POM files will be generated for Projects listed below and Parent POM file will be generated aggregating the Projects.
- Maven Artifactld and Bundle-SymbolicName should be same.

- Maven Version and Bundle-Version should be same.

- TIBCO Home and BW Home values are required to run the Unit tests defined in the Project.

Group Id: | com.tibco.bw |
Parent Artifact Id | MainProcesswithUnitTestDerno.d

Version: 1.0.0-SNAPSHO|

Unit Test Configuration :
Skip Tests: ]
Fail if No Tests : O
TIBCO Home : | C:fRutuiaOfﬁceWorkauM
BW Home : [ /bw/6.9 |

Engine Debug Port : | 8090
Deploy Options: v

Selected Projects :

Module Name Module Type Artifactld
MainProcessWithUnitTestDemo application Application  MainProcessWithUnitTestDemo.application
MainProcessWithUnitTestDemo Module AppModule  MainProcessWithUnitTestDemo

@ < Back Next > Cancel

3. Update the required configuration details (Agent, AppNode, and so on) in the

Deployment Details for TIBCO BusinessWorks™ wizard and select the appropriate
Profile.
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# Generate PO
Deployment Details for TIBCO BusinessWorks(TM) Application
Please enter the Deployment details to Deploy the EAR file to BWAgent.

Agent Host localhost Agent Port 8079
Agent Authentication v
Agent Usermame Agent Password

SSL Connection O

Truststore Path Truststore Password

Keystore Path Keystore Password

Domain MainProcessWithUnitTestDemo-Domain Description

AppSpace MainProcessWithUnitTestDemo-AppSpace Description

AppNode MainProcessWithUnitTestDemo-AppNode Description

HTTP Port 8778 OSGI Port

Config Name Value +

AppNode Configuration bw.rest.docApi.port 7777 5

Restart AppNode (@]

Profile default substvar | Bxtemal Profile Location

Redeploy the Application if exists @) EAR Upload Path

Backup Application EAR if exists @] Backup Location

o s

0 0

@ < Back Next > Finish Cancel

Here,

e The Skip upload of Archive checkbox must be selected for using the existing
EAR to be deployed on AppSpaces with different profiles, else, the profile
change is updated for all the instances of EAR deployed across AppSpaces.

* The Start on Deploy option can be used to deploy and start the application.

e The Stop Application option can be used to stop the application (version
mentioned in the pom.xml file).

e The Start Application option can be used to start the application (version
mentioned in the pom.xml file).

Note: If you are unable to see the above checkboxes, maximize your
window.

4. Click Finish. Right-click the .parent folder and run the mvn clean -install goal.

The application is now deployed on AppSpace.
Deploying Multiple EARs on the Same AppNode with Different Versions

For the application to have an updated version, you must update the version in the POM
and Manifest files of the module, the parent, and the application respectively.
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When deploying for the first time, select only the Start on Deploy option in pom.xml, which
can deploy and start the application (here, you can use the Maven > -install goal). If you
want to stop or start the application explicitly, then you must regenerate the pom.xm1 file

and select the Start Application or Stop Application options as per the requirement. Then
run the Maven > qinstall goal again.

o Important: Do not apply the Start on deploy and Start/Stop Application
options at the same time. The Start Application option must be used for apps
that are deployed and not started, or for apps that have been stopped
previously, and vice versa.

Adding Process Diagram in EAR

To add a resource folder with process diagrams in EAR, perform the following steps:

Procedure
1. In TIBCO Business Studio for BusinessWorks, go to Window > Preferences.

2. On the Preferences page, select BusinessWorks > Process Diagram. Then select the
Enable generation of process diagram checkbox on the Process Diagram page.

P o B ess Studio fo Vorks(TM ) preferences o x -
File Edit Navigate Search Project Run Window Hel
Process Process Diagram S
[al GAG CEMYyHvOvYQY® chkA(cess\J@ = Design
F ks General settings for BW Process editor. ~ ==
i ErocessiDiag o Memory Saving Mode
& SimplePr [AppSpace] v Run/Debug

& SimplePr.application [AppSpace] e [ Save information to support memory saving mode
& SimplePr.application.parent Modularity
Prompt for confirmation when adding dependency to BW module
Prompt for confirmation when converting to BW module and adding de
Process Integrity
Repair Process XSD schema element references on clean build
Enable Build Automatically
OYes ONo ® Prompt
Ungroup
Move Event Handler Activities
(@ To parent group O To Event Handler of parent group O Discard
Move Catch Activities
(@ To parent group O To Catch of parent group O Discard
Move Catch All Activities
— 4 @ To parent group O To Catch All of parent group O Discard E
& Outline ¥ | &2 API Explorer &5 Cloud Appl... & Deploy
Move Compensation Handler Activities
An outline is not available. @ To parent group O To Compensation Handler of parent group O Dis

Generate Process Diagram
[] Enable generation of process diagrams
lagram Animation

[JEnable Animated Zoom
[[J Enable Animated Connection

< >

@ Cancel

0 items selected -

3. In TIBCO Business Studio for BusinessWorks, right-click the application project and
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select Generate Process Diagrams.

file Edit Navigate Search Project Run Window Help

R GRS OGM Y HvOvAv® Sy s % Gviveevos (Quick Access || = |2 Design
& Project Explorer 3 New 2 =0
& SimplePr [AppSpace Go Into
& SimplePr.application [AppSpact B Copy ctrl+C
& SimplePr.application.parent Paste BW Ctrlsv
% Delete Delete
Rename..
Import >
Export 5
& Refresh Fs

Close Project
Close Unrelated Projects
Create Enterprise Archive (EAR)
Deploy Application..

Generate Process Diagrams

Validate

Generate POM for Application

Profile As >
2 Outline % | & API Explorer ¥ Clouc Debug As > P || & Properties 2 |22 Problems|® BW Help| & Console TR
[An outline s not available. :;nmAs i @ SimplePr.application - .

Compare With > | || Resource zr‘orizny ele

Restore from Local History... derved e

Maven 2 editable true

Dependency Visualizer > last modified 22 October 2019 1:45:03 pm

Refactor > linked false

Configure > location C:\WorkSpace\BW6.6.0V37UnitTesting\SimplePr.application

Source 5 name SimplePr.application

p— path /SimplePr.application ©
T Show Properties View < >

& SimplePr. Properties Alt+Enter

4. Run the "package" goal on the parent project.

This generates the EAR file with a resource folder having process diagrams.

Deploying EAR Using Configuration File

Before you begin
Ensure that a dummy POM file and a configuration file are present in the EAR file location.

e The following is a sample POM file:

<?xml version="1.0" encoding="UTF-8"7?>

<project xsi:schemalLocation="http://maven.apache.org/POM/4.0.0
http://maven.apache.org/xsd/maven-4.0.0.xsd"
xmlns="http://maven.apache.org/POM/4.0.0"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance'">

<modelVersion>4.0.0</modelVersion>
<groupId>com.tibco.dummy</groupId>
<artifactId>dummy-pom</artifactId>

<version>1.0</version>
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<build>
<plugins>
<plugin>
<groupId>org.apache.maven.plugins</groupId>
<artifactId>maven-dependency-plugin</artifactId>
<version>2.8</version>
</plugin>
</plugins>
</build>

</project>

The following is a sample deploymentconfig.properties file:

earUploadPath=test
externalProfileLoc=https://raw.githubusercontent.com/vpawar-
ai/temp/master/test.substvar
appSpace=RestApp.module-AppSpace
restartAppNode=false
keystorePath=
profile=default.substvar
backup=true

truststorePath=

domainDesc=

bw.Home=\bw\6.6

agentPort=8079
truststorePassword=
agentAuth=BASIC
agentHost=1localhost
httpPort=8454
appNode=RestApp.module-AppNode
osgiPort=

appSpaceDesc=

redeploy=true
tibco.Home=C:\tibco_bw6.6.1
externalProfile=false
keystorePassword=
backupLocation=C:\\Users\\vpawar\\Downloads\\backup
agentPassword=admin
skipTests=false

appNodeDesc=
project.type=AppSpace
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failIfNoTests=false
agentSSL=false
agentUsername=admin
domain=RestApp.module-Domain
deployToAdmin=true
startOnDeploy=true
stopOnly=false
startOnly=true

To deploy the EAR file of BusinessWorks Enterprise application, perform the following
steps:

Procedure
1. Open the Terminal from the path containing the EAR file, configuration file, and
dummy POM file.

2. By assuming the path as \EAR, run the following goal by providing the EAR file and
configuration file locations.

mvn com.tibco.plugins:bw6-maven-plugin:bwdeployer -
DearLocation="\EAR" -DdeploymentConfigfile="\EAR\configFile.txt"

The EAR file is deployed successfully.
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Maven Goals

The Maven plug-in in ActiveMatrix BusinessWorks simplifies the build process and enhances
project management by providing a structured approach. It helps streamline the process of
building, managing, and deploying software projects by automating tasks such as
compiling source code, managing project dependencies, and creating distributable
artifacts.

Maven goals

Lifecycle Description

Phases

clean Removes all files generated by the previous build ex-target folder.
generate- Generates any source code for inclusion in compilation.

sources

install Installs the package into the local repository, for using as a dependency in

other projects locally.

Note: When you configure the POM file to be deployed on AppSpace, the
EAR is deployed on the respective AppNode.

test Tests the compiled source code using a suitable unit testing framework. These
tests do not require the code to be packaged or deployed.

site To generate a report (target > site > bwcoverage.html/bwtest.html).

validate To validate whether a project is correct, and all the necessary information is
available.

package Takes the compiled code and packages it in its distributable format, such as a

JAR. The EAR is generated in the same workspace.

compile Compiles the source code of the project.
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Lifecycle Description
Phases
verify Runs the checks if any on the results of integration tests to ensure quality

criteria are met.

deploy Run in the build environment. It copies the final package to the remote

repository for sharing with other developers and projects.

The default Maven lifecycle consists of multiple phases. Some of them are mentioned in
the above table that are executed in a sequential order to complete the project build
process.

Considering the lifecycle phases above, the Maven plug-in performs the following steps
when a default lifecycle is used:

1.
2.

A

8.

Maven validates the project first.

Tries to compile the sources.

Runs those against the tests.

Packages the binaries (for example, jar/ear).

Runs integration tests against that package.
Verifies the integration tests.

Installs the verified package to the local repository.

Deploys the installed package to a remote repository.

Here, the Maven > install command follows the default lifecycle.

Maven Plug-in Properties

Property Descriptio  Values
n

disableMocking To disable e true: Disables mocking for all mocked
mocking activities of the BusinessWorks application.
for all

e false: Enables mocking for all mocked
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Property

disableAssertions

showFailureDetails

Descriptio
n

mocked
activities
of the
BusinessW
orks
applicatio
n.

To disable
assertions
added for
all
activities
of the
BusinessW
orks
applicatio
n.

To show
provided
input and
Gold input
in case of

test failure.

Values

activities of the BusinessWorks application.

This property can be used along with "test" and
"site" goals.

Example:

mvn test -DdisableMocking=true

e true: Assertions cannot run for all activities
that are under unit testing in the
BusinessWorks application.

e false: Assertions are run for all activities that
are under unit testing in the BusinessWorks
application.

This property can be used along with "test" and
"site" goals.

Example:

mvh test -DdisableAssertions=true

e true: It shows the failure details in the
console logs and BusinessWorks execution
report for the activities that are under unit
testing in the BusinessWorks application.

e false: It does not show the failure details in
the console logs and BusinessWorks
execution report for the activities that are
under unit testing in the BusinessWorks
application.

This property can be used along with "test" and
"site" goals. It is set to "true" by default from
BusinessWorks Maven Plug-in 2.7.1 and above.
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Property

testSuiteName

customArgEngine

Descriptio
n

To run the
Test suite.
Provide
the test
suite name
as a value
to the
property
while
running
the "test"
goal.

To pass
the custom
argument
property
file when
starting
the
BWEngine,
Create a
.properti
es file that

Values

Examples:

mvh test -DshowFailureDetails=true

mvn site -DshowFailureDetails=true

This property can be used along with "test" and
"site" goals.

Example:

mvn test -
DtestSuiteName=ActivityAssertionTestSui
te.bwts

You can also run multiple test suites in sequence by
providing the test suite names separated by a

semicolon ";".

mvn test -
DtestSuiteName=ActivityAssertionTestSui
te.bwts;FaultTestSuite.bwts

This property supports Absolute path, Relative path,
and URL-based file path.

Note: In case of relative path, you must keep the
"properties" file in the Application Project.

Example:

mvn test -
DcustomArgEngine="D:\Issues\customArgEn
gine\sample.properties"
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Property

skipInitMainProcessAct

jvities

skipInitAllNonTestProc
essActivities

Descriptio
n

has the list
of custom
arguments
in the form
of -
Dkey=valu
e. The path
of the
same
.properti
es file
must be
passed to

the
customArg

Engine
property.

To skip
init for all
main
process
activities.

To skip
init for all
non-unit
test
process

Values

where, sample.properties file has the list of
custom arguments.

e true: It skips init for all main process
activities.

e false: It initiates the main process activities.

Examples:

mvn test -
DskipInitMainProcessActivities=true

mvn site -
DskipInitMainProcessActivities=false

e true: It skips init for all non unit test
process activities.

* false: It initiates all non unit test process
activities.
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Property

startOnDeploy

Descriptio
n

activities.

To restrict
an
application
to auto-
start after
deploymen
t. By
default the

value of
startOnDe

ploy is
"true".

Values

Examples:

mvn test -
DskipInitAllNonTestProcessActivities=tr
ue

mvn site -
DskipInitAllNonTestProcessActivities=fa
lse

e true: It auto-starts the application after
deployment.

e false: It does not auto-start the application
after deployment.

Example:

mvn install -DstartOnDeploy=false
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Running Continuous Integration/Continuous
Deployment (CI/CD) using Jenkins

To run CI/CD using Jenkins, perform the following steps:

Procedure
1. On the Jenkins Dashboard, go to Manage Jenkins > Manage plugins > Available
and download the following plug-ins:

e Maven Integration
 Git Plug-in

2. On the Jenkins Dashboard, click New Item and add a name for the Maven Project,
for example BwSampleProject. Then click OK.

Jenkins All

Enter an item name

‘ BWProject

» Required field

|l Freestyle project
| This is the central feature of Jenkins. Jenkins will build your project, combining any SCM with any build system, and this can be even

used for something other than software build

@ Maven project
Build a maven project. Jenkins takes advantage of your POM files and drastically reduces the configuration

JuJ Pipeline
Orchestrates long-running activities that can span multiple build agents. Suitable for building pipelines (formerly known as workflows)
organizing complex activities that do not easily fit in free-style job type.

3. On the Configure page, set the following attributes:

a. On the General tab, add a description for the project if needed.

b. On the Source Code Management tab, select Git and add the GitHub
repository URL where the project is present.

TIBCO ActiveMatrix BusinessWorks™ Maven Plug-in




77 | Running Continuous Integration/Continuous Deployment (CI/CD) using Jenkins

Jenkins BWSampleProject

General Source Code Management Build Triggers Pre Steps Build Post Steps Build Settings Post-build Actions

Source Code Management

None
® Git
Repositories (2]
Repository URL | https://github.com/SujataDarekar/BW-Sample-Project (2)
Credentials -none- Y| ®=Add v
Advanced...
Add Repository
Branches to build n
Branch Specifier (blank for 'any’) | */master @
Add Branch

c. On the Build tab, provide the value in the Root POM field, then provide the
Maven goal in the Goals and options field to execute.

You can pass the environment variables, such as, -
Dmaven.repo.local=C:\Users$username.m2\repository so that Jenkins can
refer to a user local .m2 repository where all the dependencies are present.

Jenkins

BWSampleProject

General

Post Steps

Add post-build step v

Build Settinas

-

Source Code Management Build Triggers Pre Steps Build Post Steps Build Settings Post-build Actions
Build
Root POM UnitTestDemoProject.application.parent/pom.xml @
Goals and options clean package -Dmaven.repo.local=C:\Users\sdarekar\.m2\repository @

Advanced...

© Run only if build succeeds ) Run only if build succeeds or is unstable @ Run regardless of build result

Should the post-build steps run only for successful builds, etc.

4. Click Apply and Save.

5. Go to Project Window and clic

k Build Now.
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Troubleshooting

This section provides information on how to solve some commonly observed issues.

Issue Description Cause and Resolution

If a jar/artifact/plugin is missing in the Problems tab Cause: The palette shared jar
after importing a project. For example, the is located under <TIBCO-
"com.tibco.plette.shared.jar" jar is missing whose HOME>\bw\6.x\system\share
dependency is present in autogenerated pom.xml file. d\ . Before BW 6.8.0 it was

packaged with the Maven
plug-in installer. After BW 6.8.0
, the Maven plug-in is provided
out-of-box with BW, the
palette shared jar gets
installed in the local .m2 repo
during product installation.
You can install it again by

running the script at <TIBCO-
HOME>\bw\6.x\maven\install

.bat . Ensure the mvn --
version command works on
your machine before you run
install.bat command.

Resolution: Update the
project. Right click ->Maven-
>Update Project

When the maven project with the assertion is executed with ~ Cause: It is caused due to the

Maven Goals, the following error occurs Failed to execute  missing latest maven plug-in
goal com.tibco.plugins:bwé-maven-plugin:2.9.1:bwtest  jar at .m2 repository.
(default-bwtest) on project ERROR [qtp811813182-94]
com.tibco.bw.thor.management.bw.tests.rest.BWUnitTes Workaround:

tResource - null .
1. Place the updated jar

at TIBCO-
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Issue Description

Intermittently assertion or mocking icons are missing on

activities.

Cause and Resolution

HOME\bw\ 6. x\maven\bw
6-maven-plugin
location.

. At the same location,

update the
Install.bat and POM
file with the correct jar
version (change 2.9.1 to
2.9.2 in the script)
which is supposed to
be used.

Run install.bat which
updates and places the
latest maven plug-in jar
at .m2 repository.

Resoution: Select the Tests
tab again to see the icons.
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TIBCO Documentation and Support Services

For information about this product, you can read the documentation, contact TIBCO
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the Product Documentation website,
mainly in HTML and PDF formats.

The Product Documentation website is updated frequently and is more current than any
other documentation included with the product.

Product-Specific Documentation

The following documentation for this product is available on the TIBCO ActiveMatrix
BusinessWorks™ page:

e TIBCO ActiveMatrix BusinessWorks™ Release Notes

e TIBCO ActiveMatrix BusinessWorks™ Installation

e TIBCO ActiveMatrix BusinessWorks™ Application Development

e TIBCO ActiveMatrix BusinessWorks™ Bindings and Palettes Reference
e TIBCO ActiveMatrix BusinessWorks™ Concepts

e TIBCO ActiveMatrix BusinessWorks™ Error Codes

e TIBCO ActiveMatrix BusinessWorks™ Getting Started

e TIBCO ActiveMatrix BusinessWorks™ Migration

e TIBCO ActiveMatrix BusinessWorks™ Performance Benchmarking and Tuning
e TIBCO ActiveMatrix BusinessWorks™ REST Implementation

e TIBCO ActiveMatrix BusinessWorks™ Refactoring Best Practices

e TIBCO ActiveMatrix BusinessWorks™ Samples
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How to Contact Support for TIBCO Products

You can contact the Support team in the following ways:

e To access the Support Knowledge Base and getting personalized content about
products you are interested in, visit our product Support website.

e To create a Support case, you must have a valid maintenance or support contract
with a Cloud Software Group entity. You also need a username and password to log
in to the product Support website. If you do not have a username, you can request
one by clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to

TIBCO Community.
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Legal and Third-Party Notices

SOME CLOUD SOFTWARE GROUP, INC. (“CLOUD SG”) SOFTWARE AND CLOUD SERVICES EMBED,
BUNDLE, OR OTHERWISE INCLUDE OTHER SOFTWARE, INCLUDING OTHER CLOUD SG SOFTWARE
(COLLECTIVELY, “INCLUDED SOFTWARE”). USE OF INCLUDED SOFTWARE IS SOLELY TO ENABLE THE
FUNCTIONALITY (OR PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED CLOUD SG
SOFTWARE AND/OR CLOUD SERVICES. THE INCLUDED SOFTWARE IS NOT LICENSED TO BE USED OR
ACCESSED BY ANY OTHER CLOUD SG SOFTWARE AND/OR CLOUD SERVICES OR FOR ANY OTHER
PURPOSE.

USE OF CLOUD SG SOFTWARE AND CLOUD SERVICES IS SUBJECT TO THE TERMS AND CONDITIONS
OF AN AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED AGREEMENT, OR, IF THERE IS NO
SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER AGREEMENT WHICH IS DISPLAYED WHEN
ACCESSING, DOWNLOADING, OR INSTALLING THE SOFTWARE OR CLOUD SERVICES (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH LICENSE AGREEMENT OR CLICKWRAP
END USER AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE SOFTWARE. USE
OF THIS DOCUMENT IS SUBJECT TO THOSE SAME TERMS AND CONDITIONS, AND YOUR USE HEREOF
SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of Cloud Software
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, ActiveSpaces, Business Studio,
TIBCO Business Studio, TIBCO Designer, TIBCO Enterprise Administrator, Enterprise Message Service,
Rendezvous, and TIBCO Runtime Agent are either registered trademarks or trademarks of Cloud
Software Group, Inc. in the United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle
and/or its affiliates.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only. You acknowledge that all
rights to these third party marks are the exclusive property of their respective owners. Please refer to
Cloud SG’s Third Party Trademark Notices (https://www.cloud.com/legal) for more information.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.
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Cloud SG software may be available on multiple operating systems. However, not all operating
system platforms for a specific software version are released at the same time. See the “readme” file
for the availability of a specific version of Cloud SG software on a specific operating system platform.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SG MAY MAKE IMPROVEMENTS AND/OR CHANGES IN
THE PRODUCT(S), THE PROGRAM(S), AND/OR THE SERVICES DESCRIBED IN THIS DOCUMENT AT ANY
TIME WITHOUT NOTICE.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "README" FILES.

This and other products of Cloud SG may be covered by registered patents. For details, please refer
to the Virtual Patent Marking document located at https://www.tibco.com/patents.

Copyright © 2023-2024. Cloud Software Group, Inc. All Rights Reserved.
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